


 



Introduction 

Thank you for purchasing this Panasonic product. To ensure that you use this product 
correctly, read the User's Manual thoroughly and fully understand their contents before use. 
Programming Software GTWIN Ver.3 can be used for various GT series, however, in this 
manual, operations of GT707 series are explained as an example. Please understand that 
usable functions in GTWIN Ver.3 vary depending on each GT-series model. 

Types of Manuals 

• The following types of GT707-series Manuals are available. Refer to these manuals 
according to the functions that you are using and the applications. 

• You can download manuals from the Panasonic website 
(http://industrial.panasonic.com/ac/e/dl_center/manual/). 
Unit name or application Manual name Manual code 
Programmable Display 
GT707 

GT707 User's Manual (Hardware) WUME-GT707H 

Screen Creation Tool 
GTWIN Ver.3 

Terminal GTWIN Ver.3 
Reference Manual 

ACGM0357V9EN 

General-purpose serial 
communication 

GT-series General-purpose Serial 
Communication Manual (English Edition) 
(shared with conventional GT-series models) 

ARCT1F356E 

 
 
 

http://industrial.panasonic.com/ac/e/dl_center/manual/
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GTWIN Overview 

1.1 GTWIN Ver. 3 Overview 

1.1.1 Improved Features in Ver. 3 

The ease-of-use of the software has been improved through the addition of useful functions. 

 

  

Screen manager thumbnail display/system setting tree 

1-2 



1.1GTWIN Ver. 3 Overview 

 Improved file manager function 
The screen manager and system setting menu have been integrated into the file manager. On 
the Screen Manager tab, the thumbnail display can be used to select a screen according to its 
screen image, which reduces the time required to search for screens. The System Setting tab 
has been changed to enable direct access to the setup dialog boxes of each function. 
 Substantial parts library 

The addition of parts libraries and a parts group search function make it easy to search for 
parts. You can also register classifications as user libraries. 
 Substantial part editing functions 

Switch, lamp, and message parts have been integrated, and placed parts can be changed in a 
reciprocal manner. This enables flexible design changes. 
 Added device search function 

It is now possible to easily search for the basic communication area, switches and lamp parts, 
and the device numbers and usage locations of PLCs set to functions. This leads to major 
reductions in the time required to check and change I/O number and memory area 
assignments. 

 
 Transfer function 

A transfer difference function has been added. Because GTWIN automatically extracts and 
transfers only the data that has been changed when a screen or setting change occurs, the 
transfer time can be greatly reduced. You can also check the file properties (clock/calendar 
information) during transferring. 

 
 Context menu 

A context menu that is displayed when you right-click in the software has been added. This 
simplifies operations, which can lead to reductions in operation time. This menu is also useful 
as a guide when you are not sure what to do. 
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GTWIN Overview 

1.1.2 Integrated or Simplified Features in Ver. 3 

Compared to conventional versions of GTWIN (earlier than Ver. 3), the following functions 
have been removed. 
 Integrated and simplified items 

Classification Item Difference with conventional product 

Screen creation 

Font The GTWIN (fixed font) setting has been removed. 

Font settings The outlined font setting has been removed. 

Graphic drawing 
Rounded rectangle and rectangle have been integrated. Setting 
Radius of Rounded Square to "0" results in a rectangle and any 
other value results in a rounded rectangle. 

Parts setting Attribute The [List] screen of the parts setting dialog has been removed. 

User 
interface 

Toolbar 
The [Enable/DisableSnap] switch button has been removed. 
Press [Set Grid/Guideline] to display a dialog box in which you 
can enable/disable snap. 

GT Usage Device 
This has been integrated into the Find Device function. You can 
use an equivalent function by specifying [All Devices] in the Find 
Device dialog box. 

Display language 
switching 

The List Edit of Multi Language Strings function has been 
integrated into the [List of Strings] window. 

Bitmap editor 
The bitmap editor has been removed. Use Paint or other image 
editing software to create bitmap data, and then register it to the 
parts library. 

Functions 
Basic communication 
area 

The "BAT LOW" flag has been omitted and only "BAT" flag is 
available. 

FP Monitor This has been moved to the GT system menu. 
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GTWIN Operations 

2.1 GTWIN User Interface 

2.1.1 Names and Functions of Parts of the Screen 

 

 
 

Number Name Function 

① Menu bar All the functions that can be used in GTWIN are displayed in menus. 

② Toolbar Functions commonly used from the menu bar are displayed as icons. 
The functions are separated into six types of toolbars. 

③ File Manager 
window 

Use this window to manage screen data and configure system settings. On 
the Screen Manager tab, you can select one of three display methods: map, 
list, or thumbnail. On the System Setting tab, you can open the setup dialog 
boxes of each function directly. 

④ Parts Library 
window 

The parts used during screen creation are displayed here. You can switch 
displayed parts between libraries. You can also create user-defined libraries. 

⑤ Screen data editing 
window 

This area is used to edit the parts, character strings, and graphics displayed 
on the screen. 

⑥ Screen tab The screen number, screen name, and name of the folder where the screen 
is saved are displayed as a set. 

⑦ Search Result 
window The results of the Find Device function are displayed here. 

⑧ Character String 
List window 

You can use this window to search for and edit character strings used in 
parts or screens. When you are using language switching, you can enter 
character strings in the list. 

⑨ Parts List window The parts pasted on the screen are displayed in a list form. The parts setting 
dialog box can be opened directly by double-clicking here. 
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2.1GTWIN User Interface 

2.1.2 Menu Bar 

All the GTWIN operations and functions have been organized into menus according to 
applications. 
 

 
 

Number Name Function 

① File Commands for operating screen files, for printing, etc. are collected here. 

② Edit 
Editing commands such as cutting, copying, and pasting character strings, 
graphics, and parts as well as commands for positioning and aligning are 
collected here. 

③ View 
Commands related to the screen display such as the settings and display 
magnification of the screen grid and showing/hiding the toolbar and status 
bar are collected here. 

④ Draw Commands for specifying and setting graphics drawn on the screen such as 
characters, lines, and shapes are collected here. 

⑤ System Setting Commands such as those for the GT configuration are collected here. 

⑥ Communication Commands related to settings for communicating with the GT, transferring 
data, and verification are collected here. 

⑦ Window Commands related to windows, such as commands for the window display 
methods and for switching between windows, are collected here. 

⑧ Help Commands related to the GTWIN Help and version information, etc. are 
collected here. 
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GTWIN Operations 

2.1.3 Toolbar 
 Standard toolbar 

 
Number Name Function 
① [Undo] icon Undo the previous operation. 

② [Redo] icon Redo the operation that you undid with the [Undo] icon. 

 
• The [Undo] icon only applies to drawing and editing operations such as 

those applied to character strings, graphics, and parts and to some editor 
operations that can be performed from the menu bar. You cannot undo 
other operations. 

 

 Display toolbar 

 
 

Number Name Function 

① [Enlargement/Reduction Rate] list Display the screen at the specified magnification. 

② [Enlarge] icon Enlarge the display of the screen. 

③ [Reduce] icon Reduce the display of the screen. 

④ [Display/Hide Grid] icon Switch between displaying and hiding the grid. 

⑤ [Display/Hide Guideline] icon Switch between displaying and hiding the guideline. 

⑥ [Set Grid/Guideline] icon Open the grid/guideline setting screen. 

⑦ [Display/Hide Part Numbers] icon Switch between displaying and hiding part numbers. 

⑧ [Display/Hide Part Attributes] icon Switch between displaying and hiding part attributes. 

⑨ [Display/Hide Keyboard Parts] icon Switch between displaying and hiding keyboard parts. 

⑩ [Change On/Off of parts] icons Switch the status of the selected part between ON and OFF. 

⑪ [Parts Status] list box Switch the status of the selected lamp switch part between 
ON and OFF and the number of message parts. 

⑫ [Select Language Number] list box Switch the language number of the selected base screen. 

⑬ [Previous Screen] icon 
Open the screen whose number is immediately before the 
number of the screen being edited. If this screen is already 
open, it will be set as the active screen. 

⑭ [Next Screen] icon 
Open the screen whose number is immediately after the 
number of the screen being edited. If this screen is already 
open, it will be set as the active screen. 
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2.1GTWIN User Interface 

 Editing toolbar 

 
 

Number Name Function 

① [Alignment] icons Align the positions of the selected character strings, 
graphics, or parts. 

② [Arrange] icons 

Change the arrangement of overlapping character 
strings, graphics, and parts (change which items are in 
the front and which are in the back). 
(Parts are always arranged in the front of character 
strings and graphics.) 

③ [Group] icon Group multiple character strings, graphics, and parts. 

④ [Ungroup] icon Ungroup a set of items. 

⑤ [Reverse] icons Reverse the selected graphic or part horizontally or 
vertically. 

⑥ [Rotate] icons Rotate the selected character string, graphic, or part to 
the left or to the right. 

 
 Communication toolbar 

 
 

Number Name Function 

① [Communication Parameters] icon Open the Communication Parameters screen. 

② [GTWIN → GT Transfer All Data] icon Transfer all the data from GTWIN to the GT. 

③ [GTWIN → GT Transfer Changed Data] 
icon 

Transfer the data that has been changed from GTWIN 
to the GT. 

④ [GT → GTWIN Read All Data] icon Read all the data from the GT to GTWIN. 

⑤ [Send/Receive Selected Data] icon Send/receive the selected data. 

⑥ [Verify] icon Compare the file on the GT against the file being edited 
in GTWIN. 
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GTWIN Operations 

 Coordinate and Size toolbar 

 

The coordinates (upper-left corner) and sizes of the part selected on the base screen are 
displayed here. You can also enter values to change them. As shown in the above figure, the 
coordinates of the upper-left corner of the part selected in the active base screen window and 
the sizes of this part are displayed here. You can change the position and sizes of the 
selected part by setting the values here. 

 

As shown in the above figure, if multiple parts are selected, values that are the same for all 
the parts are displayed, and values that differ are displayed as blanks. You can change the 
positions and sizes of all the selected parts by setting the values in this situation. If no parts 
are selected, these fields are disabled. 
 
 Drawing toolbar 

Drawing functions commonly used from the menu bar are displayed as icons. 

 

Number Name Function 

① [Select] icon Select character strings, graphics, and parts. 

② [Character String] icon Enter character string. 

③ [Line] icon Draw a straight line. 

④ [Continuous Line] icon Draw a continuous straight line. 

⑤ [Rectangle/Rounded Rectangle] icon Draw a rectangle or a rounded rectangle. 

⑥ [Circle] icon Draw a circle or an oval. 

⑦ [Arc] icon Draw an arc or an arc of an oval. 

⑧ [Curve] icon Draw a curve. 

⑨ [Circular Segment] icon Draw a circular segment or a circular segment of an oval. 

⑩ [Polygon] icon Draw a polygon. 

⑪ [Fill] icon Fill an area enclosed by lines or graphics with color. 

⑫ [Read Image] icon Read an image file into the screen being edited. 

⑬ [Line Type and Color] icon Display the attributes setting screen for the selected graphic. 

⑭ [Character Type] icon Display the attributes setting screen for the selected 
character string. 
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2.2File Manager 

2.2 File Manager 

2.2.1 File Manager Function Overview 

This section provides an explanation of the file manager. 
 File manager 

 
 Names and functions of parts of the file manager 

Number Name Function 

① Screen type switching 
buttons Select the type of screens displayed in the file manager. 

② Display method 
switching buttons Select the file manager display method. 

③ Screen manager 
editing buttons 

You can edit the screen whose number you have selected such as by 
opening, copying, cutting, pasting, and deleting the screen. You can also 
perform these operations from the context menu displayed when you 
right-click the screen. 

④ Screen Manager tab Select this tab to use the screen manager functions. 

⑤ System Setting tab Displays the settings of the functions of the GT in a list. Double-click a 
function name to display its setting dialog box. 
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GTWIN Operations 

2.2.2 Switching the Screen Type in the Screen Manager 

Use the screen type switching buttons to switch the screen displayed in the screen manager. 
 Screen Manager tab 

 

Screen 
type Explanation Screen number 

range 

B Display the screen manager of the base screen. No. 0 to No. 3FF 

L  
Display the screen manager of the login screen. Use this in situations 
such as when you are creating a password entry screen when using 
the operation security function. 

No. 0 to No. F 

K 
Display the screen manager of the keyboard screen. Use this in 
situations such as when you are creating screens for entering data for 
data parts in combination with keyboard parts. 

No. 0 to No. 7 

(Note): Screen numbers are displayed in hexadecimal. The number of screens that you can actually use vary 
depending on the screen being created and the settings. 

2.2.3 Switching the Display Method in the Screen Manager 

You can select from three methods. Regardless of which method you select, you can still 
perform operations on the screen data such as copying, pasting, deleting, and setting screen 
attributes from the context menu displayed when you right-click in the screen. 

   
 Map display List display Thumbnail display 
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2.2File Manager 

2.2.4 System Settings 

On the System Setting tab, you can open the dialog boxes of the functions set on the GT. 
 System Setting tab 
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 System setting items 
Item Explanation 

GT 
Configuration 

Basic Setup Configure settings such as the basic communication area with PLC, 
backlight control, touch sound, and battery error display. 

GT Communication 
Parameters Set the conditions for communicating with the PLC. 

Clock Setting Select the clock to use (the GT clock or the PLC clock). 

Multi-Language 
Exchange 

Set the PLC device to refer to when using the language switching 
function. 

Recipe Set the PLC control device to assign when using the recipe 
function. 

SD Recipe 
Set the PLC control device to assign when using the SD recipe 
function. Also set the timeout period and the screen number being 
transferred or saved. 

Operation Security Set items such as the screen number, output device, and timeout 
period when using the operation security function. 

Auto-Paging Set items such as the screen number and the display time when 
using the auto-paging function. 

Start-up Screen Set the screen number and the display time when the software 
starts. 

SD Memory Card Set items such as the control output and free space detection when 
writing to an SD card. 

Hold Device Value Set the holding of PLC devices and GT internal devices. 

Alarm History 
Set items such as the devices to assign to alarms, the number of 
records, and the record information classification (triggered, 
acknowledged, or recovered) when using the alarm history function. 

Line Graph Set items such as the devices to perform sampling, the triggers, 
and the number of records when using the line graph function. 

Index registration Set this when setting indexes. 

Countdown Timer Set this when using the countdown timer. 

Function 

Flow Display Set the number of messages, reference device, and message 
details for the flow display. 

Write Device Set the screen, conditions, and operations when writing devices. 

Data Logging Set items such as the trigger conditions, logging target device, and 
save conditions when using the data logging function. 

Setup File 

Recipe List Register devices to a recipe and edit the devices in the recipe. 
Import and export functions are also available. 

SD Recipe List Set items such as the registration conditions and format of the SD 
recipe. 

Operation Security 
Password 

Set the security level and password when using the operation 
security function. 

 
For details on each function, refer to the Terminal GTWIN Ver.3 Reference Manual. 
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2.3Parts Library 

2.3 Parts Library 

2.3.1 Parts Library Function Overview 

This section provides an explanation of the parts library. 

 

Number Name Function 

① Library switching list 
box Select the parts library to paste in the screen. 

② Library group 
switching list box 

Select the group that is used to classify the contents of the library. 
 For the standard library, select the part type. 
 For switch and lamp libraries, you can select the design. 

③ ON/OFF display 
switching buttons 

You can press these buttons to switch and check the display image of the 
ON/OFF state of switches and lamps. 

④ Screen display size 
switching list box You can switch the size of the parts displayed in the parts library. 

⑤ Color group switching 
list box 

You can use a filter to narrow down the parts into layers classified within 
the parts library. 
 For the standard library, this is not displayed. 
 For switch and lamp libraries, you can select the color group. 

⑥ User library editing 
buttons 

You can create new parts libraries and parts groups as well as delete and 
rename them. 
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2.3.2 Parts Library Types 

The parts library is organized as shown below. 
 Parts library 

Library Group Color group Explanation 

Standard 

All None This parts library conforms to conventional GTWIN. 

Switch ─ 
These parts have a function for turning the corresponding 
PLC bit device ON/OFF. A variety of functions can be 
assigned to these parts. 

Lamp ─ The display status of these parts changes depending on the 
ON/OFF state of the corresponding PLC bit device. 

Message ─ 
These parts have a function for switching their display 
status according to the value of the corresponding PLC 
device. 

Data ─ Displays the numeric value of the PLC device on the GT 
screen. 

Bar graph ─ 
These parts have a function for displaying the changes in 
the value of the referenced PLC device as a bar graph. 
Graphs can be vertical or horizontal. 

Clock ─ 

These parts have a function for displaying the date and 
time according to the referenced clock (the GT clock/PLC 
clock). A single clock part displays one of the following 
items: year, month, day, hour, minute, second, or day of 
week. 

Line graph ─ These parts have a function for displaying the changes in 
the value of the referenced PLC device as a line graph. 

Alarm list ─ 

These parts are used to monitor PLC devices allocated to 
error statuses and to display an alarm message on the GT 
or record the history of error occurrence, etc. in the internal 
memory when an error occurs. 

Keyboard ─ These parts are used to enter numeric values that you want 
to display with data parts. 

Custom ─ 
When you want to create user-defined parts, these parts 
can be used to edit the display of the parts to use. Three 
types are available: switch, lamp, and message. 

Switch 

Real 
Metallic 
Pastel 
Icon 

Blue, Green, 
Orange, Red, 
White, Yellow 

These switch parts have been designed into real, metallic, 
pastel, and icon styles. 

Lamp 
Real  
Metallic 
Pastel 

Blue, Green, 
Orange, Red, 
White, Yellow 

These lamp parts have been designed into real, metallic, 
and pastel styles. 

Template 
(Background) 

Real  
Metallic 
Pastel 

Blue, Green, 
Orange, Red, 
White, Yellow 

These parts have been prepared for use as the background 
colors of each screen. 

Template 
(PLC) FP0R ─ These parts are used to monitor the operation indicator 

LEDs of the Panasonic PLC FP0R-series. 
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2.4Find Device/Character String List 

2.4 Find Device/Character String List 

2.4.1 Search Result Window 

• Use the [Find Device] function to display the device numbers of the reference devices and 
the devices that have been set to output on the connected PLC. 

• You can execute the search by selecting the [Find Device] menu command or by pressing 
[Update] in the Search Result window. 

 
 Search Result window 

Number Name Function 

① Device Displays the PLC device name and unit (bits/words). 

② Used for Displays the part and function for which the device is set. 

③ Used Screen/File Displays the screen number/file for which the device is set. 

 

2.4.2 Character String List Window 

• The Character String List window displays the character strings that have been entered for 
parts and in the screen. These character strings can be edited. 

 
 

Number Name Remark 

① Used Screen/File Displays the screen number/file for which the device is set. 

② Used for Displays the part and function for which the device is set. 

③ 
Language numbers 
and character 
strings 

Displays the character strings set to Language0 to Language15. You can 
edit these character strings. 
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2.5 GTWIN Ver. 3 Usage Procedures 

2.5.1 Section Overview 

This section explains the GTWIN basic operation procedures by separating them into the 
following four steps. 
 Operation procedures 

 Explanation Main operations 

① 
Starting GTWIN  
→ Displaying the file 
manager 

 Start GTWIN and create a new file. Select the GT and PLC models. 
 Set the communication area with the PLC. 
 When the sequence of operations is complete, the file manager will be 

displayed. 

② Creating a base screen 
→ Saving data 

 Double-click a screen number in the file manager to open its base screen. 
 Drag a part to place it on the base screen. 
 Press [Save As] to save the data. 

③ Transferring data to the 
GT 

 From GTWIN, select the data transfer screen. 
 You can select the transfer method from transferring all the data, the 

selected data, or the data that has been changed. 

④ Exiting GTWIN Exit GTWIN. 

 

2-14 



2.5GTWIN Ver. 3 Usage Procedures 

2.5.2 Starting GTWIN → Displaying the File Manager 

This section provides the procedure covering the steps from starting GTWIN to displaying the 
file manager. 
 Procedure 

 
1. Start → [All Programs] → [Panasonic-ID SUNX Terminal]→ [GTWIN_V3] 

→ [GTWIN_V3]. 

The [GTWIN] dialog box is displayed. 

 
Option Explanation 
Create New File Press this to create new screen data. 

Open Existing File Press this to read data that has been saved to disk. 

Read From GT Press this to read data that has been saved to the GT. 

 

2. Press [Create New File]. 

The [Select Model] dialog box is displayed. 

 

Option Explanation 

GT Model Select the GT model. You can also select a vertically oriented 
model. 

PLC Model Select a PLC model. Other companies' PLC can also be 
selected. 

Keep Current Settings Select this check box to save the settings. 
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GTWIN Operations 

 

3. Press [Next]. 

The dialog box for setting [Basic Communication Area to PLC] is displayed. 

 
4. Check the assignment of the basic communication area, and then press 

[OK]. 

GTWIN starts, and the file manager is displayed on the left side. 

 
 

 
For details on the basic communication area, refer to section 4.2Basic 
Communication Area. 
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2.5GTWIN Ver. 3 Usage Procedures 

2.5.3 Creating a Base Screen → Saving Data 

This section provides the procedure covering the steps from creating a sample of the base 
screen with the file manager to saving this sample. The following procedure assumes that you 
have already started GTWIN and displayed the file manager. 
 Procedure 

 
1. Double-click a screen number in the file manager displayed on the left side 

of GTWIN. 

 
The "Screen data editing window" corresponding to the selected screen number 
is displayed. 

2. On the [View] menu, select [Parts Library Window]. 

The parts library window is displayed on the right side of GTWIN. In the following 
figure, the base screen [B-0] and the [Switch] parts library have been selected. 

 
If the parts library is already displayed, there is no need to perform this operation. 
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3. Drag a part to place it on the base screen. 

In the following figure, two lamp switch parts have been placed on the screen. 

 
4. On the [File] menu, press [Save As]. 

A dialog box for checking the save destination will be displayed. 

5. Select the path of the save destination, enter the name of the folder to save 
the data in, and then press [Save]. 

The folder will be created, and then multiple files will be saved in the folder. 

 
• If you close the screen after placing parts or drawing in the screen data, the 

screen will be registered to the file manager and will be displayed 
highlighted in red. 

• All the screen data is saved as a folder. The number of files varies 
depending on the number of screens and the parts that are used. Do not 
mistakenly delete any of the files. To open the screen data, select the 
"GTWIN_V3 File”. 
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2.5GTWIN Ver. 3 Usage Procedures 

2.5.4 Transferring Data 

This section provides the procedure covering how to transfer screen data created in GTWIN 
to the GT. 
 Procedure 

 
1. On the [Communication] menu, select [Communication Parameters]. 

The [Communications settings] dialog box is displayed. 

 
2. Check that the network is set to [USB(GT)], and then press [OK]. 

3. On the [Communication] menu, select [Send All Data from GTWIN → GT]. 

The screen data and configuration data is transferred from GTWIN to the GT. 

 

 
• In GTWIN Ver. 3, a [Send Changed Data from GTWIN -> GT] function is 

available. This function transfers only the difference of screen data and 
setting information before and after change, which leads to great reductions 
in the transfer time. 

• You can also select the data to transfer by using the [Send/Receive 
Selected Data] function. 

 
• The USB driver must be installed for the first time that you connect to your 

PC. Refer to the GTWIN Ver.3 Installation Guide. 
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2.5.5 Exiting GTWIN 

This section provides the procedure covering how to exit GTWIN. 
 Procedure 

 
1. On the [File] menu, select [Exit]. 

You will exit [GTWIN]. 

If there are unsaved screens, a confirmation message box will be displayed. 
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Creating Screens 

3.1 Section Details 

3.1.1 Screen Creation Examples 

This section provides examples of how to place and set parts as well as how to draw parts by 
way of examples in which the following three screens are created. 
 Main panel (base screen: B-0) 

This screen is created as the main operation panel screen. 
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3.1Section Details 

  Operator ID entry screen (keyboard screen: K-0) 
This screen is created for entry of the operator's ID when the [Operator ID] data part is 
pressed on the main panel (base screen: B-0) given on the previous page. Press [ENT] on the 
keyboard to return to the main panel. 

 
 
 Language switching screen (base screen: B-2) 

This screen is created for switching of the display language when the [Change Language] 
switch is pressed on the main panel (base screen: B-0) given on the previous page. Set to 
return to the main panel when the language is selected. 
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3.2 Creating the Main Panel (Base Screen: B-0) 

3.2.1 Creating the Base Screen 
 Base screen settings 

1. Check that [B] is selected under [Screen type] in the file manager, and then 
double-click the button for screen number 0. 

 
 

Base screen 0 is created. 

 
 

 
• The open screens are displayed as tabs at the top of the screen data editing 

window. 
Even if a screen is hidden under a different window, you can bring the 
screen to the front by selecting its tab here. 
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 Base screen attributes 
Set attribute information such as the name of the screen. 

 
1. Right-click in the base screen to display the context menu, and then select 

[Screen Attribute]. 

 
The [Base Screen Attribute] dialog box is displayed. 

 
2. Enter "Operation panel" in the [Name] text box, and then press [OK]. 

This sets the name of the base screen. 

The name that you set here is the screen title that is used in lists and thumbnails 
displayed on the file manager. 

 

 
3-5 



Creating Screens 

3.2.2 Drawing and Setting Lamp Switch Parts (1) Lamp Parts 

Draw the parts that function as lamps. 
 Drawing 

 
1. Use the library switching list in the parts library to select [Lamp]. 

 
2. Drag a lamp switch part from the parts library to the base screen. 

3. SelectML0, the lamp switch part that you have placed on the screen. 

4. Drag one of the ■ marks displayed in the corners of the part to change its 
size. 

 
 Completed area (lamp parts are placed) 

The section surrounded by the yellow line indicates the completed area through this 
procedure. 
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 Setting part attributes 

 
1. Double-click the lamp switch part whose attributes you want to set. 

A dialog box for setting its attributes is displayed. 

 

2. Set the necessary attributes. 

Part 
number 

Part attribute Replacement Style Font 
settings 

ML0 Lamp/Message Replacement 
Method:  
Lamp (ON/OFF) 
Device: R100 

Select From Design 
Library, R_CB2_G 

― 

ML1 Lamp/Message Replacement 
Method:  
Lamp (ON/OFF) 
Device: R101 

Select From Design 
Library, R_CB2_O 

― 

ML2 Lamp/Message Replacement 
Method: 
Lamp (ON/OFF) 
Device: R102 

Select From Design 
Library, R_CB2_R 

― 

ML3 Lamp/Message Replacement 
Method:  
Lamp (ON/OFF) 
Device: R103 

Select From Design 
Library, R_CB2_B 

― 

• Settings that are not changed from the initial settings are listed as "-" or are 
omitted. 

 

 
• You can also set the part attributes by selecting [Parts Attribute] in the 

context menu displayed when you right-click the part. 
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3.2.3 Drawing and Setting Lamp Switch Parts (2) Switch Parts 

Draw the parts that function as switches. 
 Drawing 

 
1. Use the library switching list in the parts library to select [Switch]. 

 
2. Drag a lamp switch part from the parts library to the base screen. 

3. SelectSW0, the lamp switch part that you have placed on the screen. 

4. Drag one of the ■ marks displayed in the corners of the part to change its 
size. 

 
 Completed area (switch parts are placed) 

The sections surrounded by the yellow lines indicate the completed areas through this 
procedure. 
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 Setting part attributes 

 
1. Double-click the lamp switch part whose attributes you want to set. 

A dialog box for setting its attributes is displayed. 

 

2. Set the necessary attributes. 

Part 
number 

Part 
attribute 

Replacement Style Font settings Switch 
operation 

SW0 Switch Replacement 
Method:   
Lamp (ON/OFF) 
Device: R101 

Select From 
Design Library, 
R_SE3_W 

― Operation Mode:  
Alternate 
Output Device: R101 

SW1 Switch Replacement 
Method:  
Not Replace 

Select From 
Design Library, 
R_SB6_W 
 

Character String:  
Eng/"Clock 
Setting" 

Operation Mode:  
Change to GT 
Configuration/Clock 
Setting 

SW2 Switch Replacement 
Method:  
Not Replace 

Select From 
Design Library, 
R_SB6_W 

Character String:  
Eng/"Change 
Language" 

Operation Mode:  
Change Screen 
Screen No.:2 

SW3 Switch Replacement 
Method:  
Lamp (ON/OFF) 
Device: R100 

Select From 
Design Library, 
M_SB_G 

― Operation Mode:  
Bit Set 
Output Device: R100 
Operation Mode: 
Bit Reset 
Output Device: R102 

SW4 Switch Replacement 
Method:  
Lamp (ON/OFF) 
Device: R102 

Select From 
Design Library, 
M_SB_R 

― Operation Mode:  
Bit Reset 
Output Device: R100 
Operation Mode: 
Bit Set 
Output Device: R102 

• Settings that are not changed from the initial settings are listed as "-" or are omitted. 

 
• You can also set the part attributes by selecting [Parts Attribute] in the 

context menu displayed when you right-click the part. 
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3.2.4 Drawing and Setting Data Parts 

You can use data parts to display the contents of PLC memory. 
Also, by using these parts together with keyboard parts, you can enter data into the PLC. 
 Drawing 

 
1. Use the library group switching list in the parts library to select [Data]. 

 
2. Drag a data part from the parts library to the base screen. 

Data(display): For displaying data 
Data(Input): For inputting data 

 
 Completed area (data parts are placed) 

The sections surrounded by the yellow lines indicate the completed areas through this 
procedure. 
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 Setting part attributes 

 
1. Double-click the data part whose attributes you want to set. 

A dialog box for setting its attributes is displayed. 

 
2. Set the necessary attributes. 

Part 
number Basic setup Input 

DA0 No. of Digits: 5 
Data Format: DEC (1 Word, 
Unsigned) 
Reference Device: DT100 
Index modifier: No 
Font and Size/Number of Dots: 26 

Input: Off 

DA1 No. of Digits: 5 
Data Format: DEC (1 Word, 
Unsigned) 
Reference Device: DT101 
Index modifier: No 
Font and Size/Number of Dots: 26 

Input: Off 

DA2 No. of Digits: 4 
Data Format: DEC (1 Word, 
Unsigned) 
Reference Device: DT102 
Index modifier: No 
Display Decimal Places: 
On/Decimal Places 1 digit(s) 
Font and Size/Number of Dots: 26 

Input: Off 

DA3 No. of Digits: 4 
Data Format: DEC (1 Word, 
Unsigned) 
Reference Device: DT103 
Index modifier: No 
Font and Size/Number of Dots: 26 

Input: On 
Startup Condition: Press 
Supported Keyboard: Keyboard Screen 0 
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3.2.5 Drawing and Setting Clock Parts 

Draw the parts that display the clock. 
 Drawing 

 
1. Use the library group switching list in the parts library to select [Clock]. 

 
2. Drag a clock part from the parts library to the base screen. 

One clock part is required for each of the year, month, day, hour, minute, second, 
and day of week. Repeat these steps as many times as the required number of 
clock parts. 

3. Select   on the drawing toolbar, and then select all the placed clock 
parts. 

4. On the [Edit] menu, point to [Align], and then select the required alignment 
position on the menu that is displayed. 

 
 Completed area (clock parts are placed) 

The section surrounded by the yellow line indicates the completed area through this 
procedure. 
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 Setting part attributes 

 
1. Double-click the clock part whose attributes you want to set. 

A dialog box for setting its attributes is displayed. 

 
 

2. Set the necessary attributes. 

Part 
number Basic setup 

CL0 Clock: Hour (24 hours) 
Font and Size/Number of Dots: 24 

CL1 Clock: Minute 
Font and Size/Number of Dots: 24 
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3.2.6 Drawing Character Strings 

Draw the character strings that will be displayed on the screen. 
 Drawing 

 
1. On the [Draw] menu, select [Character String]. 

2. Place the position on the base screen where you want to place the 
character string. 

You can now enter the characters. 

 
3. Enter the desired characters. 

4. Right-click or press the <Esc> key to confirm the entered characters. 

 

 Font/graphic settings 

 
1. Select a character string that you have placed on the screen. 

2. On the [Draw] menu, select [Character Type]. 

The [Character Type] dialog box is displayed. 
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3. Set the character size and the character color. 

 
 Completed area (character strings are placed) 

The sections surrounded by the yellow lines indicate the completed areas through this 
procedure. 

 

 
• You can also use  on the drawing toolbar to place character strings. 
• You can also configure font settings by selecting [Font] in the context menu 

displayed when you right-click a character string or by clicking  on the 
drawing toolbar. 

• If you click  on the drawing toolbar, and then configure font settings 
with no part selected, this will become the default for the future character 
strings that you draw. 
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3.2.7 Drawing Graphics 

Draw graphics such as rectangles. 
 Drawing 

 
Draw the square frame around the group of parts under the "Operation control" label. 

1. On the [Draw] menu, select [Rectangle/Rounded Rectangle]. 

2. Place the position on the base screen where you want to place the rectangle. 

This confirms the starting point of the rectangle. 

 
3. Decide on the ending point of the rectangle, and then click it. 

The rectangle is drawn. 

 
 

3-16 



3.2Creating the Main Panel (Base Screen: B-0) 

 Font/graphic settings 
1. Select the graphic that you have placed, and then select [Line Type and 

Color] on the [Draw] menu. 

The [Line Type and Color] dialog box is displayed. 

 
2. Configure settings such as the line type and line color. 

 
 Completed area (graphics are placed) 

The sections surrounded by the yellow lines indicate the completed areas through this 
procedure. 

 

 
• You can also use  on the drawing toolbar to place rectangles. 
• You can also configure graphic settings by selecting [Line Type and Color] 

in the context menu displayed when you right-click a graphic or by clicking 
 on the drawing toolbar. 

• If you click  on the drawing toolbar, and then configure the graphic 
settings with no part selected, these will become the default for the future 
graphics that you draw. 
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 Changing the layout arrangement order of graphics 
As an example, this section will explain how to send a graphic backward in the situation where 
the graphic is in front of the character strings. 

 
1. Select the graphic whose layout arrangement order you want to change. 

Then, on the [Edit] menu, point to [Arrange], and then select [Send 
Backward]. 

 
 

The graphic moves behind the character strings, which makes the character 
string visible. 

 
 

 
• You can also change the layout arrangement ordering by selecting 

[Arrange] in the context menu displayed when you right-click a graphic or 
by clicking one of  on the editing toolbar. 
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3.3 Creating the Password Entry Screen (Keyboard 
Screen: K-0) 

3.3.1 Creating the Keyboard Screen 

Draw the keyboard parts to use in entering the numeric values that you want to display with 
data parts. This section explains the procedure for placing data parts and keyboard parts on 
the keyboard screen (K-0). 

 
1. Select [K] under [Screen type] in the file manager, and then double-click the 

button for screen number 0. 

 
Keyboard screen 0 is created. 

 
2. Draw a character string. 

3. Select the desired data part from the parts library, and then place the part. 

The data parts are in the [Standard] library of the parts library. 
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4. Select the keyboard parts from the parts library, and then place these parts. 

The keyboard parts are in the [Standard] library of the parts library. 

 

 Completed area (keyboard parts are placed) 
The section surrounded by the yellow line indicates the completed area through this 
procedure. 

 
 

3.3.2 Setting Keyboard Parts 

This section explains how to set the keyboard part attributes. 

 
1. Double-click keyboard part KY0. 

A dialog box for setting its attributes is displayed. 

 
2. Change the number of keys and the size of the keyboard as necessary. 

 
• In GTWIN Ver. 3, you can change the layout of the keys displayed on the 

[Basic Setup] tab in the [Keyboard Parts] dialog box by dragging these keys. 
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3.4 Creating the Language Switching Screen (Base 
Screen: B-2) 

3.4.1 Creating the Base Screen 

This section explains the procedure for placing switch parts on the base screen (B-2). 

 
1. Select [B] under [Screen type] in the file manager, and then double-click the 

button for screen number 2. 

 
Base screen 2 is created. 

 
2. Draw a character string. 

3. Select a switch part from the parts library, and then place three parts in total. 

In this example, select [R_SB6_W] from the design library for each part. 

 
 Completed area (switch parts are placed) 

The section surrounded by the yellow line indicates the completed area through this procedure. 
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3.4.2 Setting Lamp Switch Parts 

This section explains how to set, as attributes, the operations of the switches when they are 
selected. 

 
1. Double-click lamp switch part SW0. 

A dialog box for setting the attributes is displayed. 

2. Select the [Switch Operation] tab. 

3. In the [Operation Mode] list, select [Back to Previous Screen]. 

[Back to Previous Screen] is displayed under [Operation List]. 

4. Press [Add]. 

5. In the [Operation Mode] list, select [Change Language No.]. 

[Change Language No. (0)] is displayed under [Operation List]. 

 
6. Configure the same settings for SW1 and SW2. 

In the [Language No. (0 - 15)] text box for SW1 and SW2, enter 1 and 2, 
respectively. 

 
• You can use the [Add], [Copy], [Delete], [Up], and [Down] buttons to edit the 

operation mode. 
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3.4.3 Creating the List of Strings 

This section explains the procedure for using the list of strings function to enter character 
strings in English and to display these character strings. 

 
1. On the [Edit] menu, select [Character String List]. 

The Character String List window is displayed. 

 
 

2. Enter a character string in Japanese in the [Language1] column. 

 
 

3. On the [View] menu, point to [Configuration], and then select [Language1]. 

The entered character strings are switched. They are now displayed in Japanese. 
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4. Adjust the positions of character strings, the font settings, and the 
positions/sizes of graphics and parts. 

Select language number 0 before you configure the font settings. 

 

 
• You can also use the [Select Language Number] list on the display toolbar 

to switch the language number. 
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4.1 Useful Functions for Editing/Setting 

4.1.1 Part Number/Part Attribute Display Function 

You can switch between displaying and hiding part numbers and part attributes. 

 
1. On the [View] menu, select [Parts No.] or [Parts Attribute]. 

 Switch part 

 

 Lamp/message part 

 
 Data/bar graph part 

 

 Clock/keyboard part 

 

Number Switch part 
Lamp/message 
part 

Data/bar graph 
part 

Clock/keyboard 
part 

① Part number 

② Switch output device 
Reference device for 
replacement operation 

Reference device for 
data to display 

― 

③ 
Reference device for 
replacement operation 

― ― ― 

 

• For line graph parts and alarm list parts, the part number, group number, and reference 
device are displayed. 

 
• You can also use the  icons on the display toolbar to switch the 

display of the part numbers/part attributes. 
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4.1.2 Find Device Function 

In GTWIN Ver. 3, you can search through the devices used in the screen data. You can also 
change the device numbers in the Search Results window. 

 
1. On the [Edit] menu, select [Find Device]. 

The [Find Device] dialog box is displayed. 

 
 

2. Enter the device that you want to search for, and then press [Search]. 

The device search begins. The results are displayed in the [Search Result] 
window. 

 
 

3. To change the assigned device, double-click the device number field. 

The [Device Setting] dialog box is displayed. 
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4. Change the device, and then press [OK]. 

 
• You can display the attributes dialog box for the assigned part by double-

clicking the field in the [Used for] column. 
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4.1.3 Part Style Change Function 

In GTWIN Ver. 3, you can easily change the style of parts that you have placed. You can 
transfer the set attributes of the part as-is, which enables flexible support of design changes. 
 Design changes of lamp switch parts 

The following section explains the procedure for converting a switch part that has been placed 
from the [Switch] library into a switch of a different design. 

 
 

 
1. Double-click a part that has been placed. 

The [Lamp Switch Part] dialog box, which can be used to set part attributes, is 
displayed. 

2. Select the [Style] tab. 

 
3. Select [Select From Design Library], and then press [Select]. 
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The design library opens. 

 
4. Select the design to convert to, and then press [OK]. 

The selected design is displayed in the [Lamp Switch Part] dialog box. 

 
5. Press the items in the order specified by the numbers in the above figure to 

alternately select the style before and after the conversion, and then press [OK]. 

The style after the conversion is applied. Press [OK] to confirm the conversion. 

 

 
• The part attributes before the conversion are transferred as-is to the part 

after the conversion. 
• You can switch which design is OFF and which is ON by switching the 

order in which you select the items in step 4. 
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 Converting switch parts to lamp/message parts and vice-versa 
The following section explains the procedure for converting a switch part that has been placed 
from the [Switch] library into a lamp/message part. 

 

 
1. Double-click a part that has been placed. 

The [Lamp Switch Part] dialog box, which can be used to set part attributes, is 
displayed. 

 
2. Select [Lamp/Message]. 

A cautionary message informing you of the conversion from the switch part to the 
lamp/message part is displayed. 

 
3. Press [OK]. 

The part is converted to a lamp/message part, and the attribute settings in the 
dialog box are also converted. 
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4. Press [OK]. 

The style and attributes after the conversion are applied to the part. 

 
• When you convert a switch part to a lamp/message part, the [Switch 

Operation], [Option], and [Valid Condition] attributes set on the switch part 
are lost. 

• You can use the same procedure to convert a lamp/message part to a 
switch part. 

• When you convert a lamp/message part to a switch part, the [Switch 
Operation], [Option], and [Valid Condition] attributes set on the switch part 
are set to their default values. 
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 Converting lamp switch parts to custom parts 
The following section explains the procedure for converting a switch part that has been placed 
from the [Switch] library into a custom part. 

 
1. Double-click a part that has been placed. 

The [Lamp Switch Part] dialog box, which can be used to set part attributes, is 
displayed. 

2. Select the [Style] tab. 

 
3. Press the [Change to Custom Lamp/Switch] button. 

A message box for confirming the conversion method will be displayed. 

 
4. To keep the displayed image, press [Yes]. To delete this image, press [No]. 

The conversion will be performed according to the method that you select, and 
then the details after the conversion will be displayed in the dialog box. The 
following figure shows an example of the displayed image being kept. 
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5. Press [OK]. 

The style and attributes after the conversion are applied to the part. 

 
• The part attributes before the conversion are transferred as-is to the part 

after the conversion. 
• If you press [No] in step 4, only the displayed image information is cleared, 

and the transparent parts are displayed in the dialog box and the screen. 

 
• You can use the same procedure to convert a custom part to a non-custom 

part. The "Simple" style will be selected for the displayed image after 
conversion. 
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4.1.4 Custom Part Creation Function 

You can use this function to create user-defined parts. You can edit custom parts with the 
following operations. 
 Creating custom parts 

The following explanation assumes that a custom part has been placed on a base screen. 

 
1. Click a placed custom part. Then, on the [Edit] menu, select [Edit Screen]. 

Alternatively, select [Edit Screen] in the context menu that is displayed 
when you right-click the part. 

You can now edit the custom part. 

 
2. Use functions such as drawing, text entry, and bitmap insertion to edit the 

design. 

 
3. Press [OK]. 

The custom part is placed in the screen data. 

 
• Excluding the style, you can set the same part attributes for lamp switch 

parts registered to the parts library and for custom parts. 
• For the conventional GTWIN Ver. 2 and GT-series, it was only possible to 

set over 16 replacements for custom parts. However, for GTWIN Ver. 3 and 
the GT707-series, it is possible to also set up to 256 replacement messages 
for standard message parts. 
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4.1.5 Tentative Part Placement Function 

It is now possible to place parts outside of the display area of the editing screen. This enables 
the placement of parts in the margins, such as when you are creating a different editing 
screen as an option. 

 

 
• When you are using the fill function, ensure that the section to be filled 

does not overlap the effective display area and the margin area. The section 
may not be filled correctly if it overlaps these two areas. 
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4.2 Basic Communication Area 

4.2.1 What Is the Basic Communication Area? 

Communication is constantly being carried out between the GT and the PLC as shown below. 
The GT accesses PLC-side devices for two purposes. 

 
 
 Basic communication area 

This area is for system control, such as screen switching settings. PLC devices are occupied 
on a fixed basis, and communication is constantly being carried out. 

 
• Word device   For reading and writing devices handled in word units (three consecutive words) 
• Bit device   For reading and writing devices handled in bit units (three consecutive words) 
 
 References and output devices for parts 
• These are devices that are used in part functions and can be freely specified by the user. 

Communication is carried out on an ongoing basis only with those devices that are used on 
the screen currently in use. 

• With the GT, before devices are specified for part functions by way of screen creation 
through GTWIN, the "basic communication area" must be determined. 

• DT0 to DT2 and WR0 to WR2 are set as the default values for the basic communication 
area, but the initial address can be changed from the GT Configuration screen in GTWIN. 

 

 
• Use the basic communication area in the PLC ladder program to control the 

GT. 
 

Word devices (such as DT) Bit devices (such as WR) 

Three consecutive words Three consecutive words 

Constant  
communication 

Basic communication area 
For screen switching specification and system control 
(word devices/bit devices, each occupying three words) 

References and output devices for parts 
For part functions 

(free device specification) 

PLC internal devices PLC 
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4.2.2 Basic Communication Area Map 

In order for communication to be carried out between the GT and PLC, a device area like that 
shown below is provided in the PLC. Use this to control the GT through the PLC ladder 
program actually being run. 
The starting address "N" of the field shown below is specified in the GT configuration settings 
of GTWIN and is then sent to the GT. 
 
 Word devices 

Word position F E D C B A 9 8 7 6 5 4 3 2 1 0 

N + 0 Number of the screen specified by the PLC (area read by the GT from the PLC) 

N + 1 Usage prohibited 

N + 2 Number of the screen currently displayed (area written to the PLC by the GT) 

 
Explanation of the system area 
• Number of the screen specified by the PLC: The number of the screen to display on the GT 

is specified by the PLC in hexadecimal. 
• Number of the screen currently displayed: The number of the screen currently displayed on 

the GT is written to the PLC in hexadecimal. 
 
 Bit devices 

Bit position F E D C B A 9 8 7 6 5 4 3 2 1 0 

Digit position 3 2 1 0 

Byte position Higher bytes Lower bytes 

N + 0 

B
Z 

Fo
rc

ed
-d

is
pl

ay
 fl

ag
 

B
ac

kl
ig

ht
 e

na
bl

ed
 fl

ag
 

B
ac

kl
ig

ht
 b

lin
k 

  To
uc

h 
so

un
d 

di
sa

bl
e 

fla
g 

 B
ac

kl
ig

ht
 b

rig
ht

ne
ss

 

    

N + 1 Usage prohibited 

N + 2 

          SD 
m

em
or

y 
ca

rd
 

in
se

rte
d 

fla
g 

P
as

sw
or

d 
sc

re
en
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pl
ay

 fl
ag

 

Lo
gi

n 
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en
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ay

 fl
ag

 

 B
A

T 

D
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n 
pr
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ss
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ag
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Explanation of the system area 
① BZ Turns on the buzzer. 

② Forced-display flag 
While the bit is on, the screen specified by the PLC is forcibly displayed. 
(While the bit is on, the screen cannot be changed with a switch part 
whose operation mode is set to [Change Screen].) 

③ Backlight enabled flag When the bit is turned on, the backlight blink control is enabled. 

④ Backlight blink 
0: Lit (normal) 
1: Blink 

⑤ Touch sound disable flag Turning on the bit sets silent operation when touching the buttons. 

⑥ Backlight brightness 

Adjust the backlight brightness. 
0000: No brightness adjustment in the basic communication area. 
0001 to 1111: The brightness is adjusted according to the value. The larger 
the value the higher the brightness. 

⑦ Data input in progress flag This flag is 1 while data is being input and 0 when data input has been 
completed. 

⑧ BAT 

This turns on when the battery reaches the end of its service life and the 
clock data can no longer be maintained. The battery service life is detected 
when the GT turns on. If the GT is left on continually, the battery service 
life is not detected. (Note) 

⑨ Login screen display flag This flag is 1 when the login screen is displayed and 0 when the login 
screen is no longer displayed. 

⑩ Password screen display flag 
This flag is 1 when the screen for changing the password or for password 
management (for exclusive use by the administrator) is displayed and 0 
when this screen is no longer displayed. 

⑪ SD memory card inserted flag This flag is 1 when an SD memory card is inserted in the SD memory card 
slot 0 when no SD memory card is inserted. 

(Note): The dead battery mark is displayed in the lower right of the screen only when the [Battery Error Display] 
check box is selected under [Basic Setup] in the [GT Configuration] dialog box. The BAT flag activates 
regardless of the [Battery Error Display] setting. 
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